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Azotel Overview ANYWHERE

e Started as a WISP in 2002.

—Couldn’t find a good management system, so we started
developing our own.

— This means that SIMPLer is designed by people who know
what’ s involved in running a successful WISP.

* In 2005, WISP was sold so we could focus exclusively
on developing SIMPLer.

* Now deployed in excess of 50 Networks worldwide:

— Operators in North America (US & Canada), Europe (Ireland,
UK, Italy etc.) and Africa (Nigeria, Ghana, Cameroon etc.).

— Operators vary from very small with a few hundred
subscribers, up to operators providing nation-wide (lreland
and Nigeria) and province-wide (Nova Scotia, Canada)
coverage.
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N
SIMPLer Overview ANYWHERE

* SIMPLer’ =

——

Subscriber Information Management PLatform

* Single Platform used for all business functions:
— Data not entered twice anywhere in your business.
— No issues caused by conflicting or incomplete data.

 Enforces Proven Repeatable Process
— Encompasses Best Practices from around the world.

* Access Technology Agnostic
— Any radio equipment, DSL, cable etc.
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Typical Operator Functions ANYWHERE

End-User
Portal [ Helpdesk ]

[ CRM ]
[ Hotspot ]
Support
[ Coverage ] [ Network ]

Checking Monitoring

Provisioning
[ Billing ]

Inventory
Management

Bandwidth Auto
Management [ Reports ] Disconnect
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Integration with SIMPLer ANYWHERE

Cust. Rel. Mgmt.
Helpdesk "'"' Billing and Payments

S‘°“;°'J
C
Map & Coverage Chk. w .! gew\

Flexible Reporting

Hotspot Support

End-User Portal TN
R '\ \\ .l
Authentication Requi & x =
4 <« J
[ e ]
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ENABLING

SIMPLer System — Contract Service ANYWHERE

Accessible
from

—  anywhere.

CPE n

CPE 4

SIMPLer
Server

ﬂerforms all other

management functions.

Communicates with WIB WIB | :5\
only for control info — no (WISP-In-a-Box) AN TR
bearer traffic. <<
Deployment Options: S CPEI
Hosted: Located in our
kit |
Dedlcate’d: Located in and bandwidth J
operator s own data
Management
center. lig 7y
0SS Core Network Access Network
www.azotel.com Azotel Confidential Proprietary a Z Ot e I
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ENABLING

SIMPLer System — ImageStream ANYWHERE

SIMPLer
Server
WIB firmware .
on
ImageStream N\
0SS Core Network Access Network
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SIMPLer System — RADIUS

ENABLING
BROADBAND
ANYWHERE

SIMPLer
Server
and
RADIUS
Server

0SS

Core Network Access Network

3rd party \ /
bandwidth 'l - _ |
manager ' if;zis ———— Jl
supporting t -
RADIUS. . \\}\_;: E Ij
. CPE |
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SIMPLer System — Access Network

ENABLING

BROADBAND
ANYWHERE

™
-
redllneo Motorala Wireless Internet Plat form

communications

D
TRANZEO
WIRELESS TECHNOLOGIESINC

SIMPLer UBIQUITI
Server NETWORKS
Any radio network
— ®
WIB o \
(WISP-In-a-Box) alv\maurl;!egwmx Choice
‘I Cambridge
MikroTik pro>dm
0SS Core Network Access Network / o
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ENABLING

SIMPLer System — Hotspot Service ANYWHERE

SIMPLer
Server
and

RADIUS
Server &
H I B e u:':’
(Hotspot-In-a-Box) Py

((?)
0SS Core Network Access Network
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SIMPLer System — MikroTik

ENABLING

BROADBAND
ANYWHERE

SIMPLer
Server
and
RADIUS
Server

0SS

MikroTik
RouterBoard

Core Network

Access Network

()

www.azotel.com
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EROADBAND
SIMPLer - Competitive Advantage ANYWHERE

Traditional SIMPLer

Operator

Rollout Time 4 Months 30 days
Capitol Cost — Core Network 5 1

(Ratio)

Operating Cost (Ratio) 5 1
Customer Care Ad-Hoc Professional
Flexibility & Agility Poor Greatly Enhanced
Reliability Variety of Equipment 1 WIB-C
Ongoing Research & None Included

Development
High

Low
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NG
Do You Need SIMPLer? ANYWHERE

* The following is the true story of one operator who
decided that they didn’ t ...
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The Background ANYWHERE

*°In 2006, we proposed a solution to several new
operators which consisted of:

— Azotel’ s SIMPLer management platform.

— Motorola Canopy radio equipment.

— Bandwidth and hosting from a local provider.
— Finance from a local bank.

— Access to knowledge and expertise required to set up a
WISP.

—In short, everything required to set up a successful,
sustainable business, in a market where there was a clear
demand.

www.azotel.com Azotel Confidential Proprietary az Ot e I
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A
The Reaction ANYWHERE

* Many took up this offer, and now run successful,
profitable businesses.

* One decided to proceed but rejected the Azotel
component:

— They felt it was wasted money, and that they could achieve
the same result at lower cost without it.
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NN
3 Years Later ANYWHERE

* This operator had built a world-class network.

* They established a strong brand with high levels of
customer satisfaction.

* They had coverage in large areas of the country.
* They installed over 6,000 CPE devices.

e But ...
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A
The Result ANYWHERE

* A liquidator was appointed after the Collector General
filed a petition with the High Court over unpaid taxes.

* The company was acquired by a competitor for a
nominal price.
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N
The Problems ANYWHERE

* As their network grew rapidly, managing customer anc
network data without a system like SIMPLer became
impossible.

* They lost control of their customer data:

— While they’ d installed over 6,000 CPEs, they only had data
on 3,000 subscribers.

* They lost control of their billing data:

— For those 3,000 known subscribers, they couldn’t keep track
of which ones were and were not paying.
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A
The Problems ANYWHERE

* They didn’ t manage bandwidth:

—No incentive for customers to move from basic package to
higher bandwidth packages.

* They lost control of their inventory:

— The company who acquired them found an extra ~$500K
worth of equipment in warehouses which was unknown at the
time of the acquisition.
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The Underlying Reason ANYWHERE

* They focussed entirely on building a network, not on
building a business.
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Main SIMPLer Features ANYWHERE

Cust. Rel. Mgmt.
Helpdesk "'"' Billing and Payments

S‘°“;°'J
C
Map & Coverage Chk. w .! gew\

Flexible Reporting

Hotspot Support

End-User Portal

2 \_\‘\ <

Authentication Requi Y ==
4 @«
a=rT—
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Customer Relationship Managemen g

* Comprehensive customer records are kept for every
customer, from first contact through to disconnect.

* A built-in trouble ticketing system is available, to
track issues from your customers and their
resolutions.

* A built-in sales tracking system is available, to track
potential sales.

* Files of any type can be attached to customer
records.

* The operator can create their own custom fields in
the customer record.

e A Mass Email tool is available, to send informational
and marketing email to your customers.
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CRM - Customer Details Page

Aptus login: tim Customer Details
Customer Account (modify.) (history.) Financial Summary (statement..) Customer Portal (modify.) (history..)
General: Customer ID 14 Prepayments EUR0.00 CR Portal URL http:/ int.aptusbb.eu
Modi : " . Invoicing ID 000013 (Amount Remaining) Portal Username
Co tlfy cuspor;e;’ - Nickname Credits EUR0.00 CR Portal Password
ustomer Portal (Amount Remaining)
Name Terms & Conditions Not Accepted
Customer VolP Billing >> Status = Customer Balance EUR 0.00 DR P
Sales Opportunities >> Changed: 17 Nov 2010
(0 open issues) Last 5 Maintenance (add..) (all..)
General (modify.) (history..) Date Reported By Title Status Description
. ov airel istomer Installation =l stomer Installation
Invoicing: Type T T 17 Nov 2010 MaireG Cu Install closed Cu: Install
Custom Invoice >> Start Date 01 Aug 2007 16 Nov 2010 MaireG Swap Out ) closed Will send Robbie to swap out wrran( CPE(..)
Invoices details >> Initial Contact Date 27 Jul 2007 20 Oct 2010 pawel VolP Package Details in EUP closed Hi Pawel, | don't know if 'm reading (...}
Credit Card details >> Installation Date 27 Jul 2007 19 Aug 2010 MaireG Phone Issues closed Amanda is once again experiencing issues (...)
Bank Account details >> Importance 3 27 Jul 2010 MaireG No Connection or Phone closed Amanda phoned to say she had no service. (...}
Subscription details >> Customer Tracking Normal
Prepayments >> Marketing Code Corries Last 5 Open Sales Opportunities (all..)
Credits >> Marketing Emails No Date Status. Title Value Added Reseller Master Agent Regional Sales Manager Sales Team Member
Statement >> Reference Fee No Open Sales Opportunities
il Reference Fee Status
>>
B(;Ilmg Is§ues Value Added Reseller Last 5 Notes (add..) (all.)
(0 open issues) Master Agant DatefTime Reported By Title Note Text
N . Regional Sales Manager No Added Notes
.lll.l ork: . Sales Team Member . y .
Modify network details >> Groups Contact Details (modify..) (history..)
Modify IP table >> Email
Modify Equipment >> Network Details (modify.) (history.) AccountElE mal
Modify Radius >> Monitor no monitor Supports| Emall
Send network details >> Gateway  wib_153 (wib-153) 94.198.120.51 :"'P"“" U
Maintenance >> Bucket 153 VoIP Solum Duo 1 (3072/512) w‘:bsm
(0 open issues) : L, T Contacts ?
|__Map | Satelite | Hybrid
bl R o,
Search: N
Address (modify.) (history.)
Street Corries
Town
N o County Bagenalstown
Change History (Details..) Post Code eme
MaireG 17 Nov 2010 10:13 Country Ireland
fergalk 28 Sep 2010 15:06
MaireG 16 Jun 2010 09:25 Installation Area Corries
fergalk 18 May 2010 19:57 Community Code Corries
cereslk 28 Ame 2010 11: GPS Coordinates Lattitude: 52.703077
rerg © Apr 2010 1l Longitude: -6.958656
fergalk 28 Apr 2010 11:
fergalk 28 Apr 2010 11: Installation Address (modify..)
Rachel 06 Apr 2010 11: Street Line 1 Corries
Rachel 06 Apr 2010 11: Town
Rachel 06 Apr 2010 11: County Bagenalstown
Post Code Co. Carlow
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CRM - Mass Email Notification g

Mail to:
O Enter email addresses manually (separate multiple email addresses with commas)
@ Specify criteria
Customer [ All )
/ Status
Can send email to subscribers Only f:BYes Y
based on criteria including Marketing
equipment they’ re associated Group
with (for notification of planed Enabled?
maintenance etc.) and WIB number | B‘
products they’ re subscribed Access ( )
kto (for marketing promotions). Point S
Product ( B
Code
Product ( B
Description
Assigned | )
Site
Blessington m
QOL - Liscannor
. ICE-Naul
Send an email o Ardmore - Ballycotton
From (To): news@operator. il L igd s
Group Bee: ALL CUSTOME] Brian McGrath
Amocom - Kiskeam
Amocom - Rock
Hunters
. Amocom - Carrigaline (S)
Ce: Amocom - Gama*
Bee: Amocom - Ballnagree*
QOL - Bendash
Subject : Amocom - Ballygarvan
Message: Willie Moores
ge: Doonbeg
5 . ICE-Glennagad/Clonmel ~
® Plain Text Email can be |CE_R°seg,2en A
OHTML Code ?\ formatted in plain text, | QoL - Quin - Cragastka -

el

sside

ORich Text ? rich text, or HTML. J

2/



Installation, Dispatch, Provisioning

* Automated CPE provisioning for:
CANOPY
. BIRELL! alvarlc;\
MIKroTik

Your Open WiMAX Choice

— Minimises configuration required by installer, simplifying
process and removing possible causes of error.

— Automated provisioning support for other radio equipment
vendors can be easily added.

* Integration with Google Calendar allows dispatch/
installation scheduling to be performed using a user-
friendly graphical interface.

— Data is synchronised between Google Calendar and
SIMPLer, to ensure everything is kept up to date.

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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Installation - Scheduling

Create event = Quick add

Today (00 I30 Feb 27 - Mar 3, 2011

February 2011 [« ] » ]
T F
NN TEE | e
2am
7 8 9% 10 11 12 13
14 15 16 17 18 18 20
21 22 23 24 25 26 27 e
28 1 2 3 4 5 6
7 8 9 10 11 12 13 4am
My calendars - —
T
asks - Gam
Add  Settings
Other calendars - 7am
Add a friend's calendar
1 Ben Mathieu [+] 8am
1 Jason Hardy [ ~]
1 Wade Hardy [+ ] %am
6 Enrique Guirado [~ |
6 Mark Holland [~ | T
don.thomson@seasidehigl £
11am
laurie.andrychuck@seasid £
rick gallagher@seasidehig £ 12pm
ryan.t@seasidehighspeed. £
tpm
Add ¥  Settings 2om
3pm
www.azotel.com

\ /Print Refresh Day =Week Month 5Days Agenda

Mon 2/28 Tue 31 Wed 32 Thu 3/3
Tim Booked off 1B 3 Installs = 1A 3 Installs
2-3 2-3
[4A SCT 2kcunr[6B LPT
4A Service call 3fbond1] 6B
>

When: Mon, February 28, 3am — 4am

What:
e.g.. Breakfast at Tiffany's
Calendar: | 1ia - Amherst +)
1ia - Amherst
1 Ben Mathieu

6 Enrique Guirado

6 Mark Holland
don.thomson@seasidehighspeed.com
doug.acker@seaside.ns.ca
laurie.andrychuck@seaside.ns.ca
rick.gallagher@seasidehighspeed.com
ryan.t@seasidehighspeed.com
tim.macphee@seaside.ns.ca
trevor.sangster@seaside.ns.ca

INSTALLATION

[3B GRF 2smac’
38 INSTALLATII
ip-2p

3B[38 PRP 2pca saoucettell
INSTALL 429-3106 new

12:30p - 1:12:30p - 1:30p
[88 ESK [3CWSA' [1BMAP " "~
2listewart: 1plloyd1] [4B HOP

2mountai

2:30p - 3:30p
[3A LDR 2sstan’-*" "**

2:30p - 3:30p
[3A OMT 2sschneider1] 3A
MORNING ONLY PLEASE

3p - 4p
INSTALLATION, 88 [88 ESK

3nbermnard11]

Azotel Confidential Proprietary
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3:30 - 4:30
[1A POH 1gsnook1] 1A service
call power adaoter

5-6
[1A MIN ljarsenaeaul] 1A
service call

7:30 - 8:30
[1A FEW 1pmaxwelll] 1A

9-10
[4CLSM [1AELC
2mrosmar 1schapm

[4B LOR 2vconwayl] 4B
service call

48 service call 2dwebb314C

ip-2p ip - 2p ip - 2p
[JELIU [7EWHY [4CTEL
3ddcotton 3sorosper 2ilivinast

3:30 - 4:30
[2A WST 1ppatriquinil] 2A

[2A WTW 1gmcnuttl] 2A
SERVICE CALL MORNING

[3B 2mwhitel] 3B service call

7-8
[3C UST 2dwebberi] 3C

[7E HYR 3mmaciellan6) 7E
service call

9 - 10

7E [7E WHY 3stoneyl)

10-11
[7E MAB 3gmegahy1] 7E
Installation, Moming only

12:30p - 1:30p

[7A HMT 3isutherland1] 7A
SERVICE CALL RE-ALIGNMENT
1:30p - 2:30p

[4A RV) 2jwhite” *5

[3A URV 2gdstewart1] 3A
Installation, AFTERNOON 1S

azotel
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Bandwidth Management

(52 ImageStream. g Samurai Express ,.
LI |

Traffic Shaping

Buckets allow you to
Internet Feed sub-divide available

bandwidth into
smaller increments.

Total available
bandwidth for
WIB.

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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Bandwidth Management

o (& ImageStream. B Samurai Express

Internet Feed <

Assignment of
customers to buckets
allows control over
uplink & downlink
rates, PIR/CIR and
contention ratio.
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Billing and Payment Processing

* Products can be defined in a flexible way, for once-oi
and recurring charges.

— Flexible tax rates are supported to match
* Multiple payment methods are supported.
* Non-electronic payment tracking.
* Complete integrated Debtors Ledger.
* Usage-based billing

* Auto invoice generation

www.azotel.com Azotel Confidential Proprietary az Ot e I
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Billing - Payment Processing

* For Direct Debit payments, SIMPLer suppor
interfaces to multiple banking systems.

* Credit Card and E-Check payments are supported via
multiple payment gateways.

ip-pay))  momerid(@  PayPal

SOLUTIONS \{ <

J‘C-I_T I = '
IDIREC T Mm,,m
¢) paymentexpress
Authorize.Net

a CyberSource solution

* Non-electronic payments can also be tracked.

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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Billing — Customisable Invoice Forme

No: 61567
pate: 07 Oct 2010

period: 07 Oct 2010 - 07 Jan 2011

Account ID: EDDYHIGG

Payment Method: direct debit

Previous Billing Details

Previous bill: 07 Jul 2010
Direct debit Payment Received: 30 Jul 2010
Balance Brought Forward

www.azotel.com

STATEMENT / INVOICE rip’le

Azotel Confidential Proprietary
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Portal House
Raheen Business Park
Limerick

Tel: +353 21 467 1677

mail: accounts@ripplecom.net

m

LoCali: 1890 RIPPLE (1890 747753)

174.24
(174.24)
0.00

azotel
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Network Monitoring

 SIMPLer monitors equipment in the network to verity
that it’s contactable. If not, then it:

— Updates its internal dashboard (below) and map.
— Optionally sends alerts via SMS and/or email.

Server: noc.azotel.com
Local time: 2010-10-12 15:28:36

WIB monitor:

IB WIB 1B Operator |Active Started failing |Failure Description Status
numberjname Public IP Subscribers
120 |demoWIB1| 192.168.1.2 demowisp 15 Aug 2010 | Critical Failure: Cannot ping WIB [failing
22:33:01 Public address [192.168.1.2]
164 Dennis (192.168.15.201 demowisp 5 07 Oct 2010 | Critical Failure: Cannot ping WIB |[failing
WIB 10:05:43 Public address [192.168.15.201]

Neth monitor:
No customers/equipment failing.

Lp. Started failing  |Last failure P address [Customer Nickname Last45min. |Last5min. |

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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Network Monitoring

www.azotel.com

“Daily' Graph (5 Minute Average)

o
g

=]

u
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“w =
N e
a

= :
2 ;
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@

Max In: 132 Mb/s Average In: 6095.7 kb/s Current In: 6116.6 kb/
Max Out: 5883.3 kb/s Average Out: 2222.0 kb/s Current Out: 4612.9 kb/s
“Weekly' Graph (30 Minute Average)

g 20 m T ¥ 3
g

=]

Lw’ 15 n ' @ & &

® 4
N 8
a

-

w ot
- o
-

@

03 05 06 o7 08 09 10 11

Max In: 13.6 Mb/s  Average In: 64139 kb/s Current In: 8875.2 kb/

Max Out: 5709.1 kb/s Average Out: 2178.4 kb/s Current Out: 4656.2 kb/s

Azotel Confidential Proprietary
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Daily, weekly,
monthly and yearly
usage graphs can
be viewed for each
IP address or piece
of equipment.

Raw data can be
downloaded for
offline manipulation
via the excel icon.

azotel
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Inventory Management

 SIMPLer maintains equipment inventory.

. Efquilgment can have a status of “use”, “stock” or
(11 au ”:
— Use: The customer that it is being used by is displayed.
— Stock: The warehouse in which the item is located can be
specified.
— Fault: A trouble ticket can be associated with the item to
ensure the fault is resolved.

* Information such as the equipment’s IP address, MAC
address, value, purchase order number, serial
number etc. can be maintained.

 SIMPLer can automatically match CPEs to the correct
parent AP and tower based on the AP MAC address
retrieved from the CPE (for CPEs that we auto-
provision).

www.azotel.com Azotel Confidential Proprietary az Ot e I
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Inventory Management

Equipment ID  Nickname IP address Description MAC Address  Status Type Parent CPE or Base Stations
1385 S1152 192.168.113.88 CANOPY 8.1.5 SM-DES 0a-00-3e-fb-cb-fd use Canopy SM no parent Kilcully
1386 S1153 192.168.113.89 CANOPY 7.2.9 Jul 23 2005 01:49:03 0a-00-3e-f7-20-51 use Canopy SM no parent KDay
1387 Ab4 192.168.113.216 WhiteGate C70 0a-00-3e-fb-d8-c7 use Canopy AP no parent BaseStation 124
1388 BH38 192.168.113.217 FarmersJ >> WhiteGate C61 0a-00-3e-51-d5-f9 use Canopy BH no parent BaseStation 125
1389 BH39 192.168.113.218 WhiteGate>>FarmersJ C61 0a-00-3e- use Canopy BH no parent BaseStation 126
50-ab-ad
1390 S1154 192.168.133.104 CANOPY 7.3.6 Oct 24 2005 12:06:56 0a-00-3e-f0-48-15 use Canopy SM no parent JoMartin
1391 S1155 192.168.133.105 CANOPY 7.2.9 Jul 23 2005 01:49:03 0a-00-3e-f7-58-c6 use Canopy SM no parent QSint
1392 S1156 192.168.133.106 CANOPY 7.2.9 Jul 23 2005 01:49:03 0a-00-3e-f7-5c-ef use Canopy SM no parent FRGCondo
1393 S1157 192.168.133.107 CANOPY 8.1.5 SM-DES 0a-00-3e-fb-a2-ee use Canopy SM no parent PNoonan
1394 S1158 192.168.133.108 CANOPY 8.1.5 SM-DES 0a-00-3e-fb-a3-b0 use Canopy SM no parent VWalsh
1395 VPN104 192.168.104.54 VPN 104 stock Other no parent Not used
1397 VPN112 192.168.112.54 VPN 112 stock Other no parent Not used
1398 VPN105 192.168.105.54 VPN105 stock Other no parent Not used
1399 VPN113 192.168.113.54 VPN113 stock Other no parent Not used
1400 VPN2 192.168.2.54 VPN2 stock Other no parent Not used
www.azotel.com Azotel Confidential Proprietary a Z Ot e I
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End User Portal

* The End-User Portal provides a portal for subscriber
to view information about their account and perform
common actions.

— Subscribers can view and edit their personal information,
view and edit their payment method, view their current
balance, download pdf versions of invoices, make a
payment via their credit card or bank account, view their
data usage, view and purchase hotspot tokens, run a speed
test, and more.

* The functions provided by the portal are configurable,
so operators can disable any function that they don’t
want to make available to their customers.

* The portal can be customised with the operator’s
name and logo, or integrated into their own website.

www.azotel.com Azotel Confidential Proprietary aZ Ot e I

39 «ec000@ OUILSIdE



End User Portal - Functions

Azotel Technologies Ltd.

.:1-;; Home 2. Account .\3;) Network (‘_Z“, VolP (\5’) Hotspot
Account Holder — Customer Usage Summary Graph
(6 ) 7
Account ID 654321  \_/ T N,
° 1.0 1
Customers Name  Steve Smih ¢ !
Current Pay Method  Credit Card 'g ‘
|
Auto Payment Enabled ¢  o.04d | , ~
Py 12 34 16 18 20 22 0 2 4 6 8 10 12 14 16
) Customer Usage Summary
(8)
? Monthly Allowance (CAP) 10.0000 GB
Current Allowance Usage 0
/ "q" . View your most current bill below. You can view the details by clicking on the Bl Date
“"Current Bill Date Charges this month Amount Due
X 2009.02.20 € 120.00 €108
Pay Now
Copyright © 2010 Azotel Technologies Ltd.. All rights reserved Powered by AZOTEL
www.azotel.com Azotel Confidential Proprietary a Z Ot e I
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End User Portal - Functions

The “Home” Tab:
The “Account” Tab:

- Change password, access personal information, see invoices, make
payments etc.

The “Network” Tab:

- Access usage graphs, IP settings, perform speed test etc.

The “VolP” Tab:

- Access VolP account details

The “Hotspot” Tab

- Access Hotspot account, view and access tokens etc.

“Account Holder” Section
- Shows customer account details.

7. Customer Usage Summary Graph

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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End User Portal - Functions

8. Customer Usage Summary

- Outlines the customer’s monthly allowance (in the example above this is 10
GB) and their current usage.

9. Invoice Details

- Shows details of the current invoice. A payment can be made by selecting
the “Pay Now” button.

10. Support

- Opens a new email through the customer’s email client, which is to be sent to
a pre-defined support email address i.e. support@example.com.

11. Logout

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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EUP - Customisation

Home Account Network

Account Holder
Account ID ABWMN-2121

Soo
400
100
100
109

Customers Name

Current Pay Cash
Meothod

Automatic Disabled
Payment

Bits per second

A Better Wireless, NISP, LLC 4

VolP

Customer Usage Summary Graph

%
ks
ks
ks

L ]
L

4 & % 10 12 14 16 1% 30 22 @

View your most current bl below. You can view the detalls by clicking on the Bl Date.

Current Bill Date Charges this month Amount Due

¥ 2010-01-01 USD 43.85

Copyright © 2010 A Better Wireless, NISP, LLC. All rights reserved

USD 0.00

www.azotel.com Azotel Confidential Proprietary
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Authentication Required|

EUP- Integration with Operator Wek

home aboutus services contactus techsupport Iatest news LocCall 1890 RIPP53 inthe Medila Customer Log in

Feel the effects for yourself!

request info

(.} Just click the green button N NN

Lustomer Log in

User EDDYHIGG has successfully logged on

Broadband ¥ Mail ¥ Settings ¥ Log Out
Make a custom payment
Oustanding Invoices €0.00
Available Credit €0.00
Amount Due €0.00
Payment Amount 0.00
STATUS: ~
Bill Date Reference Amount Status
01 Jun 2004 546 € 290.40 paid =
01 Sep 2004 720 € 290.40 paid =
www.azotel.com Azotel Confidential Proprietary a Z Ot e I
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Auto Throttling, Disconnect

* Monitors subscribers whose
1. Invoices are overdue
2. Monthly data cap has been exceeded (if the operator chooses to set a data

cap).

* The operator can specify thresholds at which the system will:
— Send notifications to the subscriber.
— Automatically create a billing issue.
—  Throttle the subscriber by moving them to a lower bandwidth bucket.
— Disconnect the subscriber.

— Automatically charge the subscriber for additional data (in the case of a data
cap being reached).

* Disconnected subscribers can be re-directed to a web page
which informs them that their account has been suspended.

* They can still access their End User Portal so that they can
make a payment and get back online without any operator
intervention.

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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End User Portal

Web Mail Login

@harewaves.net

Please type in your full
email address to login.

VOIP Portal Access

Email Help

Frequently Asked Questions
Acceptable Use Policy
Spam Policy

Access Agreement

Privacy Policy

VOIP Terms of Service

SUPERANtiSpyware

5-Star Rated

www.azotel.com

About Us Product Coverage Support

Rocky Mountain House

Greetings, e

Disconnected
There 1s a problem with your<__ siserbersare
can tell them what they
need to do to get back
options to resolve this issue. -
Published in Rocky

to a web page which
account, Please see below for
online. /

1) Check your account balance to ensure all payments have
been processed and your account is in good standing.

Click here for the End user portal Disconnected
subscribers can still
access their End User
Portal, so they can
make a payment and

have service restored. Z Ot e I

«ec000@ OUILSIdE

(Your username is your account ID found on your bill
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Hotspot System

Hotspot service is supported via our own Hotspot-In-
A-Box (HIB) or MikroTik RouterBoards.

Ability to define tokens based on time and/or data
limits.

Ability to provide free trial service for limited time
periods, and ensure that the same customer doesn’t
abuse free trial.

Statistics on hotspot and token usage, to help refine
service offerings.

Customers can purchase new tokens via End User
Portal.

Hotspot portal pages can be customised with
operator logo/branding.

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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Hotspot - Portal Customisation

Wﬂ/a J

Broadband for Rural

Did you ever think...

you could get Broadband

Here?

Click to

Wivalley is a Local Company committed to bring the
generation of wireless broadband communications to
communities throughout the region.

Take a

Test Drive
Learn More about WiValley

. .

Please enter your username and
password

Username: | |

:&. Password: | |

Purchase User Account

[J I have read and accept both the
"Terms & Conditions" and "Acceptable

Usage Policy”

Copyright @ 2010 Wivalley, Inc.. All rights reserved

www.azotel.com Azotel Confidential Proprietary
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Hotspot - Portal Customisation

Skeyeopener

Heineken

www.azotel.com Azotel Confidential Proprietary a’z Ot e I
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Flexible Reporting

* We can provide credentials for you to be able
securely (via OpenVPN) connect to our database
using a third-party reporting application.

— This could be a commerical application such as Crystal
Reports, or a free, open source application such as iReport.

* This allows an operator to create their own complex
reports using any of the data in the SIMPLer
database, and to run these reports whenever they
want.

* We provide documentation explaining the structure of
the SIMPLer database, so that the operator knows
what each field in the database contains.

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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Flexible Reporting - Example

1)
P
O
N
(0

Site Revenue

February 2011

)
O
0
i
5
0
Ll
:

Revenue per site based on invoices generated

mainfeg
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ayeT usp3
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Jany s feuieg
“equsp3
‘uy Ajjo4

lI'H weyeio
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Jany Asuo |
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1,000 1
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Mapping and Coverage Checking

* Positions of customers and equipment can be viewe
on Google Maps or Google Earth.
— If positions of potential and “survey failed” customers are
recorded, this can give a graphical view of the locations of

potential customers, which can be used to help plan
expansion of the network.

* An Iintgrated coverage checker is available. This
allows you to determine line of sight between your
Access Points and a potential customer, taking into
account factors like Fresnel zone clearance and path
loss.

www.azotel.com Azotel Confidential Proprietary aZ Ot e I

52 «ec000@ OUILSIdE



www.azotel.com

P

P
Data S10. NOAALUIS. Navy. NGA. GEBCO
©2010 Cnes/Spot'image
Image'® 2010 DigitalGlobe
Image © 2010,GeoEye
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@ current

@ current - no monito
@ potential

@ installed

@ post

Q waiting for install
@ survey failed

@ migrated

@ squeaky wheel

Q@ unused

sites

K

L)
A production

Options

e
e
e
e
0

@ 3D Terrain
Geographic data
3D Builidings
Trees

Roads

Sun

Download KMZ File
Switch to Google Map

‘,W(,Qoglc

Reset
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Mapping — Integrated Coverage Ch

SPLAT! Path Profile Between Start Point and End Point (59.13° azinuth)
Hith First Fresnel Zone

network

: ; Point-to-Point Profile ——

: : Line of Sight Path ——
T T || RS B sons 2 ey on o eyt o GO Earth’s Curvature Contour —
: Flrst resnel Zone (56800,808 HHz) —
60% of Flrst Fresnel Zone —

410 [ ~~~~~~~~~~~~~~~~~~~~~~~~ ————————————————————————— ——————————————————————————
S SU— SO - REN—-
e T ~~~~~~~~~~~~~~~~~~~~~~~ e n S, e s -
sl ,,,,,,,,,,,,,,,,,,,,,, ,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,

370 [E-sseusiinsseesiiises . ...................... R ........................ _

Start Point and End Point {neters)

Nornalized Height Referenced To LOS Path Between
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Mapping — Path Loss

www.azotel.com

General | Tools

customers

Q@ current

@ current - no monitor
@ waiting for survey
@ potential

@ post

Q enquiry

sites

&)
A production

coverage graphs

(]

v

‘ line of sight

path loss

GE options

e
e
e
e
e

Download KMZ File
Switch to Google Map

DatalS|O NOAATUISANavySNGAYGEBCO
Image © 201} EQropqan Sba'céuilvfhaj;ing‘
Image ©2011/Institutolde/CaitografialdelAndalucia

Image ©:2011iDigitalGlobe -
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Helpdesk Service

 Support calls from end customers can be directed
Azotel’s helpdesk, which is manned by staff who are
experienced in resolving typical customer issues with
broadband services.

* This allows an operator to provide 24-hour, 7-day-a-
week support to their end customers without the
overhead of having to recruit and manage their own
dedicated helpdesk staff.

 Sales calls from potential new customers inquiring
about service can also be handled.
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56 «ec000@ OUILSIdE



ENABLING?~
BROADBAND

Agenda ANYWHERE

* Azotel Overview

* SIMPLer Overview

* Why You Need SIMPLer — A Case Study

* Key Features

SSIMPLer Process Maps
* Three Steps to WISP Setup

* Our Customers

* Our Partners/Distributors/Resellers

* New Operator Setup Process
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SIMPLer Process Maps — Map 1

ENABLING

BROADBAND
ANYWHERE

S//\//PL er’

PROCESS MAP 1

* Add a new customer record

* Add relevant products.

« Set state = Waiting for Install

* Customer record goes into
dispatch queue for installer to be
assigned.

» Use Google calendar to find a
suitable timeslot and schedule
install.

* Synchronisation process
automatically updates data in
both SIMPLer and calendar.

* Installer gets nightly email
summarising jobs for next day.

» All details are accessible on
the road via Google calendar.

« If using auto provisioning
SIMPLer automatically
configures IP address NAT,
bandwidth settings.

« State = Current.

- Customer flagged on “First
Invoice” list. Allows details to be
verified before invoice is issued.

* Subsequently, invoices can be
auto-generated.

- Payments via direct debit and
credit card can be automated.

www.azotel.com
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SIMPLer Process Maps - Map 2

ENABLING

BROADBAND
ANYWHERE

SIMPL &r

PROCESS MAP 2

v
@ HELP DESK INVENTORY

SALES/MARKETING

MANAGEMENT

* Provide support to end
customers.

» Address typical customer
issues — no connectivity,
low throughput, can’t
access email etc.

» Escalate network issues to
NOC.

* Open maintenance tickets
if repair/replacement of
CPE is required.

* Maintain network topology
in SIMPLer.

* Monitor health of network —
WIBs, APs, BHs,
throughput etc.

*Perform planned
maintenance activities.

* Use diagnostic tools
(tcpdump etc.) to
investigate network issues.

* Mass email notification for
planed maintenance.

* Auto collection of MAC
address, software version
etc. during CPE
provisioning.

*Possible to pre-load
equipment list to SIMPLer.

* Maintain inventory of
available equipment and
associated warehouse.

* Maintain site costs,
scheduled maintenance
dates etc.

+ Use “potential” state to
maintain data on potential
new customers.

* Use built-in sales tracking
system.

* Mass email notification for
promotional use.

* Monitor financial statistics,
customer growth etc.

* Visibility across all
functions from one
platform.

www.azotel.com
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ENABLING?~
BROADBAND

Agenda ANYWHERE

* Azotel Overview

* SIMPLer Overview

* Why You Need SIMPLer — A Case Study

* Key Features

* SIMPLer Process Maps
Y
* Our Customers

* Our Partners/Distributors/Resellers

* New Operator Setup Process
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ENABLING

Three Steps to WISP Setup ANYWHERE

* Step 1 — Take Azotel WIB-C (AZBWIB-400) and connec
to upstream connection (Fibre, Satellite, Leased Line
etc)

Step 1: Connect Power and Internet Feed

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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Three Steps to WISP Setup

ENABLING

BROADBAND
ANYWHERE

* Step 2 — Connect Radio Network (e.g. Canopy AP)

www.azotel.com

Step 2: Connect Radio Network to LAN-2

Azotel Confidential Proprietary
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ENABLING'

Three Steps to WISP Setup ANYWHERE

e Step 3 — Connect Customers

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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ENABLING-

B
Agenda ANYWHERE

* Azotel Overview

* SIMPLer Overview

* Why You Need SIMPLer — A Case Study

* Key Features

* SIMPLer Process Maps

* Three Steps to WISP Setup

Jour Customers
* Our Partners/Distributors/Resellers

* New Operator Setup Process
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NG
Our Customers ... ANYWHERE
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ENABLING
BROADBAND

ANYWHERE

“We finally have a back-end system that
¢ does exactly what we need it to. Thank
| you Azotel for understanding our
L business.”

- David Horton, Seaside High-Speed
Internet

ég’{y Wd@

HIGH-SPEEDINTERNET

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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ENABLING
BROADBAND

ANYWHERE

“The Azotel platform allows Ripple
to focus on the core aspect of
caring for our customers’ needs.
Simply put, Azotel is a one-stop
turn-key solution that provides a
fully comprehensive system.”

- Lawrence Mulligan, Ripple e —
Communications

L

communications

www.azotel.com Azotel Confidential Proprietary az Ot e I
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ENABLING
BROADBAND
ANYWHERE

“From the start, the service from Azotel has been
impeccable. Azotel has provided us with a faultless
service and has taken the hassle out of setting up a
wireless broadband network in a short period of
time.”

- Aine Hales, AHC Networks

AHC wireless broadband

networks

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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ENABLING
BROADBAND
ANYWHERE

“Compared to the system we had before,

Azotel SIMPLer has been an improvement
of 1000%.”

- Mitch Koep, A Better Wireless

A B s =t WiReEL=5D

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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ENABLING?~
BROADBAND
ANYWHERE

= . “With Azotel we plugged into an expert
’ knowledge base from the outset. With
Azotel SIMPLer powering the Airwave
Internet broadband network we have
saved time and money and continue to
do so on a daily basis.”

- John Barry, Airwave Internet

Alrwavéw

Internet

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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ENABLINGs
BROADBAND
ANYWHERE

“On a scale of 0-10, ten being the highest, | rate
Azotel Technical Support and Training as an 11. | am
still amazed.”

- Grant Daniel, CommWorld of McCall

‘.’\ McCall

CommWorld

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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ENABLING?~
BROADBAND

Agenda ANYWHERE

* Azotel Overview

* SIMPLer Overview

* Why You Need SIMPLer — A Case Study
* Key Features

* SIMPLer Process Maps

* Three Steps to WISP Setup

e Our Customers

J Our Partners/Distributors/Resellers

* New Operator Setup Process
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ENABLING

Our Partners - Motorola ANVWHERE

EMEA MOTOwi4 Application:
“Operator in a Box” via Azotel

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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ENABLING

Our Partners - ImageStream ANYWHERE

“Most service providers need an integrated billing
and provisioning solution. Azotel has been very
careful to avoid the kinds of pitfalls that hamstring
other systems. Our partnership with Azotel is
important news for our customers in the ISP and
carrier markets.”

- J.C. Utter, ImageStream

ImageStream.
Leading the Router Revolution

www.azotel.com Azotel Confidential Proprietary aZ Ot e I
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AR o
Our Distributors/Resellers ... ANYWHERE

A
\ ¥ -

o(+(@ multisource S~

See http://www.azotel.com/distributors-and-resellers/
for contact details.
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ENABLING?~
BROADBAND

Agenda ANYWHERE

* Azotel Overview

* SIMPLer Overview

* Why You Need SIMPLer — A Case Study
* Key Features

* SIMPLer Process Maps

* Three Steps to WISP Setup

* Our Customers

e Our Partners/Distributors/Resellers

d New Operator Setup Process
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ENABLING

New Operator Setup Process — Part ANYWHERE

. Azotel will provide all relevant documentation
+  Become familiar with documents. Printing hardcopies is recommended.

'Provide Azotel with the following to complete setup:
-« Company Logo
] Payment Gateway(s) (e.g. Authorize.net)

‘o Getcustomer import spreadsheet from Azotel
¢  Fill customer details into spreadsheet and send back to Azotel
. Provide equipment list
»  Get current network configuration
_ « Indentify any changes to the network design for de ployment
Yes . +  Update network information in SIMPLer
Legend:
.. Verify customer data - Operastor Process
No '« Verify network settings .
e Verify WISP global settings (users->Modify WISP) Bl i Process
/ - Azoted Process
‘ Degsion
- Doaunent
v
www.azotel.com Azotel Confidential Proprietary a Z Ot e I
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New Operator Setup Process — Part

Install WIB on local network (test bench)

www.azotel.com

Create test network behind WIB

Create test customer
“Install’ customer

Setup products

Update customer subscriptions
Invoice customer

Clear invoice

'+ Add employee accounts with appropriate roles & pemissions

Configure and deploy the WIB(s) into the live network
Verify customer traffic
Prepare for first invoice run

Azotel Confidential Proprietary
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Thank You ENABLING

BROADBAND
ANYWHERE
~Solutions

° ENTERPRISE

@ IRELAND

ImageStream.

Leading the Router Revolution

°(€. m‘ul’risou-rc‘e | a ZOte I A_’lﬂllMﬂ's

Your Single Wireless Connection. A tquc/ of .enius.

R imternet solutions .
3 ecss0® OLICSIdE
AHC : % ripple
mif™> dgavue

&KT“E‘WAV Bankoflreland (=)

4& / mmmmmm ications
& J $

" McCall
amocom e Caller:  ommilorid

( Gateway PREMIUM |
Airwavéw '

onnecting Africa

)1
\ lea [ [e A BEITER WiRELESS
SEASIQ% Broadband for Rural Co - =_ GRANITE
APTUS BROADBAND
part of your life
BROADBAND
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+27-

S
1

info@azotel.com
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ENABLING

Backup Slides ANYWHERE

 Master Portal
e General Administration

e Documentation
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Master Portal - SIMPLer Instances ANYWHERE
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NG
Master Portal — Overall View ANYWHERE
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ENABLING

Master Portal - Example ANYWHERE

-

Azotel Technologies Ltd. I
«ssss0 OULSIdE
User: tim
Group: all
search stats neth installer calendars sales calendars users | (Logout) |
Operator Instances Available:
Server Instance Each sub-network
seal.azotel.com zone1 © can be accessed
seal.azotel.com zone2 S directly from the
sea2.azotel.com zone3 B) Master Portal.
sea2.azotel.com zone4 ©)
seal.azotel.com radtest ©
sea2.azotel.com ballot O]
Search
Search Type: | customers Status: | 4] Search:
copyright © 2010 Azotel Technologies Ltd. All rights reserved.
www.azotel.com Azotel Confidential Proprietary a Z Ot e
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N
General Administration ANYWHERE

* Multiple User Account levels.

* Multiple Access Control Rights to further restrict
certain functions.

* Multi-Language support.

* Technical Support: comprehensive suite of tools and
capabilities provided to eff|C|entIy operate the

network.

* Comprehensive training.

e Customisation.
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ENABLING

General Administration — User Righ ANYWHERE

Azotel login: tim
User ID tim
Mail tim@azotel.com
Status [ (1) Administrator (full access) [+
WISP [ azotel v
Language [ english $
Modify password
Password
Confirm
Sales Items
Distributor ( B‘
Reseller ( B‘
Azotel Sales Contact ( -+
Landing Page [ Customer Search Page B‘
Change Default Search Option [ Customer-wise 4
R tly Viewed Cust List
Displayed By | Display Name B
Numbers to be displayed (a B‘

CCIear All Righ!s) CSeIect All Rights)

User Rights

attachments access ¥ add @ modify not-owned [ billing information [
network information (] maintenance ] sales tracking [

billingissues access ¥ send ¥

credits access ¥ add @ modify ¥

customers access ¥ add @ modify @ search @

mass email @ spreadsheets ¥ creditcard @ bankdetails @

mask bank account ¥ privatenote ¥ modify subscriptions ¥

customfields access ¥ modify @

www.azotel.com Azotel Confidential Proprietary az Ot e I
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A
Documentation ANYWHERE

Recently Viewed Customers

azotel

«sssse® OUILSIdE i
i Documentation
stats map customers invoices products network hotspots voip rad tools users logout
wireless broadband

Ripplecom login: tim Search for information about customers

Manage Customers
Add a new customer >> Display customers by status >>

Change customer monitoring status >> Change customer 'marketing emails' status >>
Change customer invoicing status >>

Group ( 4
( ™

@® Standard (Name, Nickname, Invoicing ID) Colour 'J
O Name Site basedon | 4
O Nickname "colour”
O Invoicing ID Basestation ( I
O Customer ID based on
O IP address "colour”
O Bank Details Assigned Site | 4
O Custom Fields Gateway ( B
O Customer-wise

Type ‘ >
Search: Status |

Status Change From: ( =

Date EC_-

To: 4 | s ]
Tracking ( s

Sort Order [ Descending |+ ]

- » Y@  Search Current )
(€. View Customer List / Search ) €, Search Current
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Documentation

azotel

home

about azotel

-.css0@ OLILSIAE

solutions products

e —

documentation

Americas +1 312 239 0680

how to buy faq customers

EMEA +353 21 234 8100

media

contact us

ENABLING
BROADBAND
ANYWHERE

ENABLING BROADBAND ANYWHERE

azotel documents: intro to SIMPLer |

| radio equipment | other

Note: To view document please contact us. We will send you user name and password so you will be able access our documents.
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Title

New Operator Workflow
SIMPLer Operators Manual
SIMPLer Billing Manual
SIMPLer Calendar User's Guide
SIMPLer EFT Overview
SIMPLer OpenVPN Guide
SIMPLer Sales Tracking User's Guide
SIMPLer Quick Start Tutorials
Hotspot User's Guide

End-User Portal User’s Guide

Auto Notification, Throttling and Disconnect User's
Guide

RADIUS Integration User’s Guide
HIB Quick Start Guide
WIB Quick Start Guide

All Operator Manuals

File name
10005_New_Operator_Workflow_v02.pdf
06043_SIMPLer_Operators_Manual_v105.pdf
06003_SIMPLer_Billing_Manual_v013.pdf
08007_SIMPLer_Calendar_v005.pdf
07013_AZOTEL-EFT-Overview_001.pdf
09201_SIMPLer_OpenVPN_goo-4.pdf
10014_SIMPLer Sales Tracking Guide_v001.pdf
09202_SIMPLer_Quick_Start_Tutorials_004.pdf
10016_Hotspots_Guide_001.pdf
10024_End_User_Portal_Guide_v001.pdf
10022_SAND_v100.pdf

10017_SIMPLer_Radius_|Integration_v004.pdf
09016_HIB-C_Quick_Installation_002.pdf
07074_WIB-C_Quick_Start_010.pdf

All Operator Manuals.zip

Size
24.kB
246 MB
7.0 MB
8.8 MB
14.7 kB
988.9 kB
1.1 MB
3.7 MB
10.1 MB
3.9MB
2.8 MB

8.6 MB

191.9kB
765.1 kB
67.8 MB

Link

View »
View »
View »
View »
View »
View »
View »
View »
View »
View »

View »

View »
View »
View »

View »

zotel
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